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Abstract

These Application Notes describe the procedures for configuring Session Initiation Protocol
(SIP) Trunking between the service provider AT&T Mobility in Puerto Rico and Avaya IP
Office 7.0.

AT&T Mobility SIP Trunk Services in Puerto Rico provides PSTN access via a SIP trunk
between the enterprise and the AT&T network as an alternative to legacy analog or digital
trunks. This approach generally results in lower cost for the enterprise.

AT&T Mobility in Puerto Rico is a member of the Avaya DevConnect Service Provider
program. Information in these Application Notes has been obtained through DevConnect
compliance testing and additional technical discussions. Testing was conducted via the
DevConnect Program at the Avaya Solution and Interoperability Test Lab.
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1. Introduction

These Application Notes describe the procedures for configuring Session Initiation Protocol
(SIP) Trunking between the service provider AT&T Mobility in Puerto Rico and an Avaya IP
Office solution.

In the sample configuration, the Avaya IP Office solution consists of an Avaya IP Office 500v2
Release 7.0, Avaya Voicemail Pro, Avaya IP Office Softphone, and Avaya H.323, digital, and
analog endpoints.

The AT&T Mobility SIP Trunk Service referenced within these Application Notes is designed
for business customers. The service enables local and long distance PSTN calling via standards
based SIP trunks as an alternative to legacy analog or digital trunks, without the need for
additional TDM enterprise gateways and the associated maintenance costs.

During the next pages and for brevity in these Application Notes, the service provider’s name
“AT&T Mobility in Puerto Rico” will be abbreviated and referred as “AT&T Mobility” or just as
“AT&T”.

2. General Test Approach and Test Results

The test approach was to configure a simulated enterprise site in the Test Lab, using Avaya IP
Office, connecting to the AT&T SIP Trunk Service in Puerto Rico, by means of a SIP trunk over
the Internet. This scenario may differ from a real customer environment in Puerto Rico, in which
a private network connection could be provided by AT&T to the customer site.

The configuration shown in Figure 1 was used to exercise the features and functionality tests
listed in Section 2.1.

AT&T Mobility SIP Trunk Services in Puerto Rico passed compliance testing.

2.1. Interoperability Compliance Testing

To verify SIP trunking interoperability, the following features and functionality were covered
during the interoperability compliance test:

e Response to SIP OPTIONS queries.

e Incoming PSTN calls to various phone types. Phone types included H.323, digital, and
analog telephones at the enterprise. All inbound PSTN calls were routed to the enterprise
across the SIP trunk from the service provider.

e Outgoing PSTN calls from various phone types. Phone types included H.323, digital, and
analog telephones at the enterprise. All outbound PSTN calls were routed from the
enterprise across the SIP trunk to the service provider.
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e Inbound and outbound PSTN calls to/from soft clients. Avaya IP Office Softphone was
used in the tests as a SIP client, and Avaya IP Office Phone Manager as the soft client for
H.323

e Various call types including: local, long distance, international, outbound toll-free,
emergency (911) and directory assistance (411 and 611).

e Codecs G.729A and G.711MU.

e Caller ID presentation and Caller ID restriction

e DTMF transmission using RFC 2833

e Voicemail navigation for inbound and outbound calls

e User features such as hold and resume, transfer, and conference

e Off-net call forwarding and twinning

e Use of the SIP REFER method as an alternative approach to performing call forwarding
and call transfer of inbound calls back to the PSTN.

e T-38 Faxing.

Items not supported or not tested included the following:
e Operator services such a dialing 0 or 0 + 10 digits are not supported in this offer by
AT&T in Puerto Rico.

2.2. Test Results

Interoperability testing with AT&T was completed with successful results for all test cases with
the exception of the observations/limitations described below:

e Call Display on PSTN transferred calls — Caller ID display was not properly updated
on a PSTN phone involved in a call transferred from the IP Office. After the call
transfer was completed, the PSTN phone did not display the actual connected party but
instead showed the ID of the host extension that initiated the transfer.

e Call Display on Twinned Calls. Caller ID display on the mobile phone associated with a
“twinned” extension in the IP Office will display the ID of the host extension and not the
one of the actual connected party.

2.3. Support

For technical support on the Avaya products described in these Application Notes visit
http://support.avaya.com.

For technical support on the AT&T Mobility SIP Trunk Services offer, call the AT&T Mobility
Network Operations Center at 787-717-9900.
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3. Reference Configuration

Figure 1 below illustrates the test configuration. It shows an enterprise site connected to AT&T
SIP Trunk Service through the public IP network.

Located at the enterprise site is an Avaya [P Office 500v2 with analog and digital extensions
expansion modules, as well as a VCM64 (Voice Compression Module) for supporting VoIP
codecs. The LAN port of Avaya IP Office is connected to the enterprise LAN while the WAN
port is connected to the public IP network. Endpoints include Avaya 9600 Series IP Telephones
(with H.323 firmware), Avaya 1408 and 9508D Digital Telephones, an Avaya 6210 Analog
Telephone, an Officejet 4500 fax machine and Avaya IP Office Softphones in H.323 and SIP
modes. The site also has a a Windows XP PC running Avaya IP Office Manager to configure and
administer the Avaya IP Office, and Avaya Voicemail Pro for providing voice messaging
service to the Avaya IP Office users. Mobile Twinning is configured for some of the Avaya IP
Office users so that calls to these users’ extensions will also ring and can be answered at the
configured mobile phones.
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Figure 1: Test Configuration

For security purposes, private addresses are shown in these Application Notes for the IP Office
WAN and the ITSP network interfaces, instead of the real public IP addresses used during the
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tests. Also PSTN routable phone numbers used in the compliance test have been changed to non-
routable ones.

For the purposes of the compliance test, users dialed a short code of 9 + N digits to make calls
across the SIP trunk to AT&T. The short code of 9 was stripped off by Avaya IP Office but the
remaining N digits were sent unaltered to AT&T. Since Puerto Rico is a country member of the
North American Numbering Plan (NANP), the user dialed 10 digits for local calls, and 11 (1 +
10) digits for other calls between the NANP. Thus for these NANP calls, Avaya IP Office sent
10 or 11 digits in the Request URI and the To header of an outbound SIP INVITE message. For
inbound calls, AT&T sent 10 digits in the Request URI and the To header of inbound SIP
INVITE messages.

IP Office can be configured to use either SIP Trunk Registration or Static IP Authentication with
the service provider. These Application Notes shows the IP Office using the Static IP
Authentication method with AT&T.

In an actual customer configuration, the enterprise site may also include additional network
components between the service provider and the Avaya IP Office such as a session border
controller or data firewall. A complete discussion of the configuration of these devices is beyond
the scope of these Application Notes. However, it should be noted that SIP and RTP traffic
between the service provider and the Avaya IP Office must be allowed to pass through these
devices.

4. Equipment and Software Validated

The following equipment and software were used for the sample configuration provided:

Component \ Version
Avaya
Avaya IP Office 500v2 7.0 (5)
Avaya IP Office Digital Expansion Module 9.0 (5)
DCPx16
Avaya IP Office Manager 9.0 (5)
Avaya IP Office Voicemail Pro 7.0 .17
Avaya 9620 IP Telephone (H.323) Avaya one-X Deskphone Edition 3.1
Avaya 9640 IP Telephone (H.323) Avaya one-X Deskphone Edition 3.1
Avaya Digital Telephone 1408 N/A
Avaya Digital Phone 9508 N/A
Avaya [P Office Phone Manager 4.2.39
Avaya IP Office Softphone 3.1.2.17 59616
AT&T Mobility SIP Trunk Service
Acme-Packet Net-Net 4250 SBC Firmware SC6.1.0 MR-9 GA (Build
938)
BroadWorks Soft Switch R17
Nortel CS2K PSTN Gateway CVM11
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5. Configure IP Office

This section describes the Avaya IP Office configuration to support connectivity to the AT&T
Mobility SIP Trunk Service. Avaya IP Office is configured through the Avaya IP Office
Manager PC application. From the PC running the Avaya IP Office Manager application, select
Start > Programs - IP Office > Manager to launch the application. Navigate to File
- Open Configuration, sclect the proper Avaya IP Office system from the pop-up window,
and log in with the appropriate credentials. A management window will appear similar to the one
shown in the next section.

The appearance of the IP Office Manager can be customized using the View menu. In the
screens presented in this section, the View menu was configured to show the Navigation pane on
the left side, the Group pane in the center and the Details pane on the right side. These panes will
be referenced throughout the Avaya IP Office configuration. Proper licensing as well as standard
feature configurations that are not directly related to the interfacing with the service provider
(such as LAN interface to the enterprise site, Twinning and IP Office Softphone support) is
assumed to be already in place, and they are not part of this Application Notes.

5.1. LAN2 Settings

In the sample configuration, IP500V2 was used as the system name, and the WAN port was used to
connect the Avaya [P Office to the public network. The LAN2 settings correspond to the WAN port
on the Avaya IP Office. To access the LAN2 settings, first navigate to System (1) 2> IP500V2 in
the Navigation and Group panes and then navigate to the LAN2-> LAN Settings tab in the
Details pane. Set the IP Address field to the IP address assigned to the Avaya IP Office WAN
port. Set the IP Mask field to the mask used on the public network. All other parameters should
be set according to customer requirements.

IP Offices E IP500V2*

...... MName

R Bo0TP (39 " —1| System | LAM1  LANZ |DNS | Yoicemnail | Telephory | Directory Services | System Events | SMTP I SMDR | Twi]
Operator (3) S IPS0OY2 -

| IPSOnYE LAM 2ettings |'v'oIP I Metwoark Tapalogy I

-y Syskem (1)

..... 7 Line (191 IP Address |1?2 16 1 . 50

----- <2 Contral Unit {5) P Mask |255 o255 . o255 . 0

----- Ay Extension (26)

..... g User (283 Primary Trans. IP Address I a .o . 0o .0

----- ai! HuntGroup (1) ) )

_____ 83 Short Cade (61) Firewall Profile |<N0ne> ﬂ
----- @ Service (0) RIF Mode [ ore =
----- ol RAS (1)

----- € Incoming Call Route (4) ™ Enable naT

----- 48 wanPort (0 l?

. Directory (0) MNumber OF DHCP IP Addresses  |200 =

£ Time: Profile (0) DHCP Mode

g IF:':';E::I:E;;"B(I) ’7(' Server " Client " Dialin &+ Disabled advanced
----- @ Account Code (0)
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On the VolIP tab in the Details pane, check the SIP Trunks Enable box to enable the
configuration of SIP trunks. The RTP Port Number Range can be customized to a specific
range of receive ports for the RTP media. Based on this setting, Avaya IP Office would request
RTP media be sent to a UDP port in the configurable range for calls using LAN2. Avaya IP
Office can also be configured to mark the Differentiated Services Code Point (DSCP) in the IP
header with specific values to support Quality of Services policies for both signaling and media.
The DSCP field is the value used for media and the SIG DSCP is the value used for signaling.
The specific values used for the compliance test are shown in the example below.

On the RTP Keepalives section at the bottom of the page, set the Scope field to RTP, and
Initial keepalives to Enabled. In a scenario like the one used for the compliance test, where no
network address translation (NAT) was used at the IP Office site, this will help compensate for
the NAT late binding algorithm used in the service provider’s network, and avoid problems of
media deadlock with certain types of transferred calls that are routed from the IP Office back to
the network, over the same SIP trunk.

All other parameters should be set according to customer requirements.
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--am Directory (00
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" SIP Registrar Enable
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™ H323 Auto-create Extn - =
Port Range (Minimum)  |S0000 <
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= Haz3 auto-create User

Enable RTCP Monitoring
~ Cn Port 5005

—DiffSery Settings

IBB 3: D'SCP{HER) IFC 3: DSCP Mask (Hex) |88

SIG DSCP (Hesx)

|45 32 DSCP |63 3: DSCP Mask. |34 3: 531G DSCP
—DHCP Settings

Primary Site Specific Option Mumber (SSOM) 176

Secondary Sike Specific Option Mumber {SSOM) 242

WLAMN INot Present 2 l
1100 Yoice YLAN Site Specific Opkion Mumber {S50M) |232 3:

1100 Yaice YLAN IDs |

—RTF Keepalives

Periodic l—
o AT Eimeout 0
Initial Iﬁ
keepalives Enabled ¥
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On the Network Topology tab in the Details pane, configure the following parameters:

» Select the Firewall/NAT Type from the pull-down menu to the option that matches the
network configuration. No firewall or network address translation (NAT) device was
used in the compliance test as shown in Figure 1, so the parameter was set to Open
Internet. With this configuration, the STUN Server IP Address and STUN Port are not

used.

* Set Binding Refresh Time (seconds) to 780. This value is used as one input to determine
the frequency at which Avaya IP Office will send SIP OPTIONS messages to the service
provider. See Section 5.9 for complete details.

» Set Public IP Address to the IP address of LAN2.

* Set Public Port to 5060.

» All other parameters should be set according to customer requirements.

-y System (1)

..... 7 Line {19}

----- <2z Contral Unik (S
----- A Extension (26)

----- 2 User (28)

----- ;ﬂ HunbGraup (1)

----- B3 short Code (610
----- @ Service (0]

..... A RAS (1)

..... @ Incoming Call Route (4)
..... B warPart (0)
g Directory (0)
-7 Time Prafile (0)

----- {8} Firewall Profile (1)
----- Bl IF Route (3)

----- B Account Code (0}

IP Offices E IP500V2"

Iame

S IPSO00YZ

System | LaM1  LANZ |DNS | Yoicemail | Telephorry | Directory Services | System Events | SMTP | SMDR I T

LA Settingsl yoIp  Metwork Topology |

— Mebwork Topology Discovery

STUM Server IP Address I 69 . 90 . 165 . 13 STUM Park |34?3 3;

Firewall{MAT Type joren Intermet =l

Binding Refresh Time

(seconds) 180

Public IP Address [12 16 . 1 .5

Public Port ISDISD 3: Run STUN | Cancel
™ Run STUN on starkup

In the compliance test, the LAN1 interface was used to connect the Avaya IP Office to the
enterprise site [P network. The LANT1 interface configuration is not directly relevant to the
interface with AT&T SIP Trunk Services, and therefore is not described in these Application

Notes.
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5.2. System Telephony Settings
Navigate to the Telephony - Telephony Tab in the Details Pane. Set the Automatic Codec
Preference for the default codec to be used for intra-enterprise traffic. Choose the Companding
Law typical for the enterprise location. For North America, ULAW is used. Uncheck the Inhibit
Off-Switch Forward/Transfer box to allow call forwarding and call transfer to the PSTN via
the service provider across the SIP trunk.

File  Edit Tools  Help

EQOTP (3)
Operator (3}
' IPS00VZ
2y Syskem (1)
- Ling (19)
----- <= Control Unit (53
----- A Extension (26)
----- § User (28
----- & HuntGroup (1)
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----- @ Incoming Call Route (4)
@ ‘WanPort {0}
----- am Directory (0)
----- »’.“ Time Profile (07
----- @ Firewall Profile (1)
----- BB IF Route (3)
----- & Account Code (0)
----- e, Licence (377
----- @& Tunnel {0}
----- 3 User Rights (8)
..... E BRS (1)
..... g'x E911 System (1)
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r
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 aLaw  ALAW Line

Dial Delay Time (secs)
Dial Delay Count
Default Mo Answer Time {secs) 15
Hold Timeout {secs) 120
Park Timeout {secs) 300

Ring Delay {secs)

o ahdal ol

Call Priority Promation Time {secs)  |Disabled
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Automatic Codec Preference

-
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¥ Dial By [ame
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5.3. Twinning Calling Party Settings

Navigate to the Twinning tab on the Details Pane. Uncheck the Send original calling party
information for Mobile Twinning box. This will allow the Caller ID for Twinning to be
controlled by the setting on the SIP Line (Section 5.4). In Avaya IP Office 7.0, this setting also
impacts the Caller ID for call forwarding.

ﬁ Avaya IP Dffice R7 Manager IP500%2 [7.0{5)] [Administrator{Administrator)]

Fie  Edt  View  Tools

Help

IP Offices =] IP500V2

R BOOTP (3)

i Operator (3)

IPS00YZ

*iap System (1)

Line {19)

-2y Contral Unit {59
A Extension (26)

@ User (28)

ﬂ HunkGroup (1)

- @% Short Code (81}
- Service ()
g RAS (1)

Rk 0L

- Incaming Call Route (4)
a ]

[Harne . ; . _—
[Em—— Syshem | LAMI1 I LAMNZ I DMS I Volcemalll Telephonyl Direckary Serwcesl System Events I SMTP | SMDR  Twinning |VCM | CCR I
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Caling party information For I
Mobile Twinning
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5.4. Administer SIP Line

A SIP line is needed to establish the SIP connection between Avaya IP Office and the AT&T SIP
Trunk Service. To create a SIP line, begin by navigating to Line in the Navigation Pane. Right-
click and select New— SIP Line. On the SIP Line tab in the Details Pane, configure the
parameters as shown below:

IP Offices E SIP Line - Line 17*
Line Murnber

o K EOOTP (3)

Set the ITSP Domain Name to the [P address of the [P Office, LAN2. With this setting
IP Office will use this IP address as the host portion of the SIP URI in SIP headers, such
as From headers.

Check the In Service box.

Check the Check OOS box. With this option selected, IP Office will use the SIP
OPTIONS method to periodically check the SIP Line

Set Call Routing Method to To Header. On inbound calls to the IP Office, AT&T will
include the customer’s “lead” DID number in the Request URI in the INVITE message
of every call, and the actual DID number of the called party in the To header. Selecting
the Call Routing Method to Te Header, IP Office will use the To header to direct the
call to the intended destination, ignoring the Request URI in this decision.

Set Send Caller ID to Diversion Header. This field is only used if the Send original
calling party information for Mobile Twinning box is unchecked in Section 5.3.

For twinning and call forwarding off-net calls, Avaya IP Office will include the
Diversion header in the outbound SIP INVITE message. The Diversion header will
contain the number of the re-directing party in IP Office, and the From header will
contain the original caller number. The number in the Diversion Header is known to
AT&T but the number in the From header is not. At the time of the compliance test,
AT&T allowed these calls to complete, based on the known number sent by IP Office on
the Diversion header, but the original caller-ID number present in the From header is not
being propagated to the called PSTN party. This is a limitation in the feature
implementation by AT&T. At the time of writing these Application Notes, this issue is
under review by AT&T engineers for a resolution.

SIP Line |Transp0rt| SIP URI| voIP | 738 Fax | 5IP Credentials|

Operator (3) 1
= IPSOMV2 s Ling Mumber |1? =
-5y System (1) w17
_____ 7 Line (19) 201 ITSP Domain Name  [172.16.1.50 In Service Ird
------ < Contral Uit (5) THz02 lUse Tel LRI r
----- A Extension (26) T4z03
..... § useres) 1204 Prefix I Check 005 v
----- 1“ HuntGroup (1) Fiz05 . ) )
_____ 8% Short Code (61) 1;"'206 Mational Prefix IU Call Rauting Methad ITo Header j
..... Service (0 . Originator number For
_____ % RAS (1)( ) T_‘,ZD? Sy Emily I Forwarded and bwinning calls I
T
----- @ Incoming Call Route (4) ;."zgg Inkermational Prefix IDD
----- £8 wanPart (0) 1‘__"210 ——
..o Directary (01 1;_‘.211 Send Caller ID IDlversmn Header J
£ Time Profile (0) -' ot
< Association Method  |By Source IP address hd
----- @- Firewall Profile {13 T_"212 I J
..... B I Route (3) a3 [V REFER Support
""" & Account Code (0) TH214 Incamin Always =
----- W Licence (37) Tiais s I v J
----- & Turnel {0) Toz1e Outgoing IAIways j
----- § 3 User Rights ()
..... . K ARS (1)
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e Check the REFER support box. Select Always for both Incoming and Outgoing to
enable the IP Office to send REFER headers for transferred and forwarded calls that are
routed back to the PSTN.

e Default values

may be used for all other parameters.

Select the Transport tab and set the following:

[ ]
e Set the Layer
[
[ ]
e Default values

4 Protocol to UDP.

may be used for all other parameters.

Set the ITSP Proxy Address to the [P address of the AT&T P. R. proxy server.

Set Use Network Topology Info to LAN2 as configured in Section 5.1.
Set the Send Port to 5060.

IP Offices E Ei SIP Line - Line 17°
BOOTP (3) Line Mumber || spe Line Transport |stp URI|volP | 138 Fax| SiP Credentials|
Operator (3) #1
IPSO0Y2 -2 ITSP Proxy Address [10.1.1.1
29 System (1) 17
T Line (19) 4201 Metwork Configuration
----- 2 Control Unit (S) 1202 Iﬁ
-
_____ & Extension (263 208 Layer 4 Probocol uoP Send Park  |S060 =
""" g User (28) THz04 Use Metwork Topology Info ILP.N z 'l Listen Pork ISDE:D 3:
----- 2§ HuntGroup (1) F1
F 205
----- 8 short Code (61 7
_____ @ service (0 (e1) THz08 ExpictDNSServer(sy [0 - o . 0 .o [o o 0
ervice Fie07
""" s RAS (LY FTo08 Calls Route via Registrar [V
) T
----- e Incoming Call Route {4) 208
----- 2 wanPort (0) Fio10
4w Direckory (00 T"I Separate Reqgistrar I
£ Time: Profile (0) 4-__'211
i ey
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A SIP URI entry must be created to match each incoming number that Avaya IP Office will
accept on this line. To create a SIP URI entry, first select the SIP URI tab. Click the Add button
and the New Channel areca will appear at the bottom of the pane. For the compliance test, a
single SIP URI entry was created that matched any number assigned to an Avaya IP Office user.
The entry was created with the parameters shown below.
e Set Local URI, Contact, Display Name and PAI to Use Internal Data. This setting
allows calls on this line whose SIP URI matches the number set in the SIP tab of any
User as shown in Section 5.6.

e Associate this line with an incoming line group by entering a line group number in the
Incoming Group field. This line group number will be used in defining incoming call
routes for this line. Similarly, associate the line to an outgoing line group using the
Outgoing Group field. The outgoing line group number is used in defining short codes
for routing outbound traffic to this line. For the compliance test, a new incoming and
outgoing group 17 was defined that only contains this line (line 17).

e Set Max Calls per Channel to the number of simultaneous SIP calls that are allowed
using this SIP URI pattern.

e Default values may be used for all other parameters.

IP Offices m =] SIP Line -Line 17

BOOTR (3) T_‘j“""“ber SIP Line| Transport TP UR |yl | 738 Fax| S1P Credentials|

Operator (3) !

IPS00WZ w2 Channel | Groups | Wia | Local URI | Conkack | Display Mame | FAl | Credential | IMax Calls
--#5 System (13 .17 1 17 17 1. 0 <MNo... 10
----- 7 Line (19) FH201
----- <2 Contraol Unit (5) FHz02
----- Ay Extension (26) 205
----- i User (23} FHz04
----- aﬂ Hunt@roup (1) 1208
----- ax Shor!: Code (617 208
----- @ Service () iz
..... & IRAS(}) Call Route (4) 208

@ ncoming Call Route 20
----- $8 wanPart () Fisn
----- am Direckary (0) T"I
{7 Time Prafile (0) rf211
----- @ Firewall Profile (1) Tj212
----- B 1P Route (3) (REE
----- & Account Code (07 4214
..... &, Licence (37) 4215 —Edit Channel
""" i Tunnel (0) THe1s ¥ia [trz.18.1.50
----- § User Rights (8)

----- ¢ AR 1) Local URI |

----- fx E911 System (1)
Cantack IUse Irternial Data j
Display Name IUse Internal Data j
PAT IUse Internal Data j
Registration ID: =Mone = j
Incoming Group Il?
Oukgaing Group Il?
Max Calls per Channel IlD 3:
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Select the VoIP tab to set the Voice over Internet Protocol parameters of the SIP line. Set the
parameters as shown below:

e The Compression Mode was configured using the Advanced button, allowing an
explicit ordered list of codecs to be specified. Check marks next to G.729(a) 8K CS-
ACELP and G.711 ULAW 64K, which are the codecs supported by AT&T, in that
specific order of preference.

e Select T38 for Fax Transport Support, which is the fax standard supported by AT&T.

e Set the DTMF Support field to RFC2833. This directs Avaya IP Office to send DTMF
tones using RTP events messages as defined in RFC2833.

e Uncheck the VolIP Silence Suppression box.

e Check the Re-invite Supported box to allow for codec re-negotiation in cases where the
target of an incoming call or transfer does not support the codec originally negotiated on
the trunk.

e Default values may be used for all other parameters.

SIP Line -Line 17*

Campression Made ﬂ G.729(a) 8K CS5-ACELP ™ valP Silence SUppression

[ G711 LA 64K ¥ Re-invite Supparted
[ G711 alaw a4k

[T |G.723.1 6K3 MP-MLG

™ Use OFferer's Preferred Codec

[T Codec Lockdown

Fax Transport Suppork |T38 j
Call Initiakion Timeout {5} |4 5:
DTMF Support [RFCza33 |

Since default values were used for T38 fax, and AT&T Mobility SIP Trunk Service in Puerto
Rico does not require Trunk Registration, the T38 Fax and SIP Credentials tabs need not be
visited.
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5.5. Short Code
Define a short code to route outbound traffic to the SIP line. To create a short code, right-click
on Short Code in the Navigation Pane and select New. On the Short Code tab in the Details
Pane, configure the parameters as shown below.
e Inthe Code field, enter the dial string which will trigger this short code, followed by a
semi-colon. In this case, 9/V; . This short code will be invoked when the user dials 9
followed by any number.

e Set Feature to Dial. This is the action that the short code will perform.

e Set Telephone Number to N”@10.1.1.17. This field is used to construct the Request
URI and To headers in the outgoing SIP INVITE message. The value N represents the
number dialed by the user. The IP address of the AT&T SIP proxy server follows the @
sign in the above expression.

e Set the Line Group Id to the outgoing line group number defined on the SIP URI tab on
the SIP Line in Section 5.4. This short code will use this line group when placing the
outbound call

e Default values may be used for all other parameters.

IP Offices Short...
R BOOTP (3 Code =1 short Code |
Operator {3) Bac+a0
| PSOOY2 8x 01 Cods [on;
55 System (1) oz -
. -
..... 7 Line {1%) BR*03 Feature IDIa| J
""" = Contral Unit (S} 404 Telephone Mumber IN"@IU-I-I-I"
----- Ay Extension (26) xS
..... § useries) Bx*s Line Group Id Il? j
----- 2§ HuntGroup (1) BMAOTH S
Locale Urited States (LS English hd
----- o ShorF Code (617 B+ I ¢ alsh) J
----- B service (0) P9 Force Account Code [
----- s RF\S(U B0
----- @ Incoming Call Route (4) N

The simple “ON;” short code illustrated above, although effectively routes the outbound calls to
the SIP trunk, does not provide the means of alternate routing if the configured SIP Line is out of
service or temporarily unavailable, or other features like Secondary Dial Tone. When alternate
routing options and/or more customized features and analysis of the digits following the short
code are desired, the Automatic Route Selection (ARS) feature may be used. ARS was
implemented and tested during the compliance tests, but its configuration is beyond the scope of
these Application Notes.
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5.6. Users

Configure the SIP parameters for each user that will be placing and receiving calls via the SIP
line defined in Section 5.4. To configure these settings, first navigate to User in the left
Navigation Pane, then select the name of the user to be modified in the center Group Pane. In the
example below, the name of the user is Extn 1105. Select the SIP tab in the Details Pane.

The values entered for the SIP Name and Contact fields are used as the user part of the SIP URI
in the From header for outgoing SIP trunk calls. In addition, these settings are used to match
against the SIP URI of incoming calls without having to enter this number as an explicit SIP URI
for the SIP line (Section 5.4). The example below shows the settings for user “Extn 1105”. The
SIP Name and Contact are set to one of the DID numbers assigned to the enterprise by AT&T.
In the example, the DID number 7871111235 was used. The SIP Display Name (Alias)
parameter can optionally be configured with a descriptive name.

IP Offices E B Extn 1105: 1105
Mame
- & BOOTR (3) % Forwarding | Dial In I Voice Recording I Button Pragramming | Menu Pragramming | Mobility | Phane Manager Options | Hunt Group Membership I Announcements  SIP
o Operator (3) Extn 1105
- [PSO0VZ Extniiidep SIP Mame [re71111z35
5y System (1) Extni10Zdcp
-7 Line {19) Extnl103dcp SIP Display Mame {Alias) IExtn 1105
<2 Control Uit (5) Extni 10+ . [eriiiizss
- 4y Exkension (26) Extnili06
@ User (28) Extni 107
15' Huntéraup (1) Extn1108 I Anonymous
~@% Short Code (61) Extnli09
@ service (0) Extnl110
3 ?n’:irf'\:rzg Call Route (4) Exint1tt
B} wanPart (0) :x:nﬁi
s Directory {0} o
€1 Time Profile {0} Extnillt
(@8} Firewall Profile {1} Extni1ls
-l 1P Eoyte (3 Extni1le
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5.7. Incoming Call Route

Incoming call routes map inbound DID numbers on a specific line to internal extensions, hunt
groups, short codes, voicemail, etc. in the IP Office. Incoming call routes should be defined for
each DID number assigned by the service provider, matching incoming numbers on the SIP line
with defined destinations in IP Office.

In a scenario like the one used for the compliance test, only one incoming route is needed, which
allows any incoming number arriving on the SIP trunk to reach any extension in IP Office. The
routing decision for the call is based on the parameters already configured for Call Routing
Method, the SIP URI (Section 5.4) and the users SIP Name and Contact fields, already
populated with the assigned AT&T DID numbers (Section 5.6)

From the left Navigation Pane, right-click on Incoming Call Route and select New.
On the Details Pane, under the Standard tab, set the parameters as show bellow:

e Set Bearer Capacity to Any Voice.
e Set the Line Group Id to the incoming line group of the SIP line defined in Section 5.4.
e Default values may be used for all other parameters.

“romees e Jg

i R BOOTR (3) Lin Group | Standard |'-.-'u:uiu:e Recarding I Drestinations I
beqde Operator (3) @0
-2 IPS00Y2 e Bearer Capability IP.n\,-' Woice j
e 51,-.-'
) - S.ystem (1) Line Group Id Il? j
----- T4 Line (19)
""" “= Control Unit (5} Incorming Murmber I
----- 4y Extension (26
..... g User (28] Incorning Sub Address I

----- & HuntGroup (1)

Incoming CLI
----- @ short Code (610 ncoming |

..... @ Service {0) Locale I j
..... I._%{ RAS (1)
----- 2 Incoming Call Route (3 Priority |1 ~Low b

..... Eﬁj W anPort (0
- . Tag I
..... @ Directary (0)

P— '
----- £4% Time Prafile (00 Hald Music Source IS';.-'stem Source j
----- @ Firewall Profile {1}

(Y34

Under the Destinations tab, enter “.” as the Default Value. This will enable all incoming calls to
be routed to any extension.

= 17
Standard I ‘oice Recording
TimePrafile Destination Fallback Extensi
» Default Yalue . ﬂ
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5.8. Privacy/Anonymous Calls

For outbound calls with privacy (anonymous) enabled, Avaya IP Office will replace the calling
party number in the From and Contact headers of the SIP INVITE message with “restricted” and
“anonymous” respectively. Avaya IP Office can be configured to use the P-Preferred-Identity
(PPI) or P-Asserted-Identity (PAI) header to pass the actual calling party information for
authentication and billing. By default, Avaya IP Office will use PPI for privacy. For the
compliance test, PAI was used for the purposes of privacy.

To configure Avaya IP Office to use PAI for privacy calls, navigate to User = NoUser in the
Navigation Pane. Select the Source Numbers tab in the Details Pane. Click the Add button.

IP Offices NoUser: *

...a BOOTP (3 - User | Vaicemail I DHD | ShorkCodes  Source Mumbers |Te|eph|:|ny | Forwarding | Dial In | ‘Woice Recording | Bul
[-¢% Operator (3)
[=-4%0 IPSO0YE Source Murber I

---*-n,- Syskem (1)
E-FT Line (199

“= Contral Unit (5]
ﬂ} Extension (26)
E|§ User {Z8)
g Malser

E ; RemateMar
~ @ 1101 Extnl

At the bottom of the Details Pane, the Source Number field will appear. Enter
SIP_USE_PAI_FOR_PRIVACY. Click OK.

Edit Source Number
’V Source Mumber SIP_LISE_PAI_FOR_PRIVACY

The SIP_USE_PAI _FOR PRIVACY parameter will appear in the list of Source Numbers as
shown below.

IP Offices 7 NoUser

a BOOTR (3) 2| User | \u'cnicemaill DD I ShortCodes  Source Mumbers |Te|e|:|h|:|nv| Forwardingl Dial InI Woice Recaordin
[-45 Operator (3)
[=-%=p IPS00Y2 Source Mumber

-5 System (1) SIP LSE PAT FOR PRIVACT

-7 Line (19)

[+ Contral Unit {5}
@ Extension (26)
E|i Liser (28)
g MoUser

e ;I'.".I Rernakeldar
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5.9. SIP Options

Avaya IP Office sends SIP OPTIONS messages periodically to determine if the SIP connection
is active. The rate at which the messages are sent is determined by the combination of the
Binding Refresh Time (in seconds) set on the Network Topology tab in Section 5.1 and the
SIP_OPTIONS_PERIOD parameter (in minutes) that can be set on the Source Number tab of
the NoUser user. The OPTIONS period is determined in the following manner:

e Ifno SIP_OPTIONS_PERIOD parameter is defined and the Binding Refresh Time is
0, then the default value of 44 seconds is used.

e To establish a period less than 42 seconds, do not define a SIP_OPTIONS_PERIOD
parameter and set the Binding Refresh Time to a value less than 42 secs. The OPTIONS
message period will be equal to the Binding Refresh Time.

e To establish a period greater than 42 seconds, a SIP_OPTIONS_PERIOD parameter
must be defined. The Binding Refresh Time must be set to a value greater than 42 secs.

The OPTIONS message period will be the smaller of the Binding Refresh Time and the
SIP_OPTIONS_PERIOD.

To configure the SIP._OPTIONS PERIOD parameter, navigate to User - NoUser in the
Navigation Pane. Select the Source Numbers tab in the Details Pane. Click the Add button.

IP Offices i NoUser: *

=R BOOTP (3) -

57 Cperator (3) User | Woicemail | DHD | ShortCodes  Source Mumbers |Te\ephuny’ | Forwarding | Dial In | Yoice Recording | Butbon Programming I Menu Programming | Mobility | Phone Manager Options I Hunt Group Mem 4| *
% Operator

= Psomvz Source Murber | Add...
= System (1) EIP USE PAL FOR PRIVACY :
:T,I Ezitf'lolg)unlt ﬂl
-y Extension (; Edit..,
o i

At the bottom of the Details Pane, the Source Number field will appear. Enter

SIP_OPTIONS_PERIOD=X, where X is the desired value in minutes. Click OK.

Edit Source Number
Source Mumber SIP_CPTIONS_PERIOD=5

MA; Reviewed: Solution & Interoperability Test Lab Application Notes 19 of 27

SPOC 8/24/2011 ©2011 Avaya Inc. All Rights Reserved. ATTPR-SipTrIPO7



The SIP_OPTIONS_PERIOD parameter will appear in the list of Source Numbers as shown below.
For the compliance test, an OPTIONS period of 3 minutes was desired. The Binding Refresh Time
was set to 180 seconds (3 minutes) in Section 5.1. The SIP_OPTIONS_PERIOD was set to 5
minutes. Avaya [P Office chose the Binding Refresh Time of 180 seconds (3 Minutes) as the smaller
of these two values. Click the OK button (not shown).

IP Offices = NoUser:

---R BOOTR {3) 211 User | Yaicemail I DD | ShortCodes  Source Mumbers |Telephnny | Forwarding | Dial In | Yoice Recording | Buttol
e Operator {3)

= IPSO00YZ Source Number I

(-5 System (1) SIP_USE_PAI FOR_PRIVACY

W7 Line (19) SIP_OPTIONS PERIOD=5

-2 Contral Unit (5
@ Extension (28]
E|{ User (28)
g Malser

5.10. Save Configuration
Navigate to File > Save Configuration in the menu bar at the top left of the screen to save the
configuration performed in the preceding sections.

6. AT&T Mobility SIP Trunking Configuration

AT&T Mobilty in Puerto Rico is responsible for the configuration of the AT&T SIP Trunk
service. The customer will need to provide the IP address used to reach the Avaya IP Office at
the enterprise site. AT&T will provide the customer the necessary information to configure the
Avaya [P Office SIP connection to AT&T including:

e [P address of the AT&T SIP Proxy server.

e Supported codecs.

e DID numbers.

e All IP addresses and port numbers used for signaling or media that will need access to the
enterprise network through any security devices.
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7. Verification Steps

The following

steps may be used to verify the configuration:

e Use the Avaya IP Office System Status application to verify the state of the SIP
connection. Launch the application from Start > Programs - IP Office
- System Status on the PC where Avaya [P Office Manager was installed. Log in
using the appropriate credentials, and select the SIP line of interest from the left pane. On
the Status tab in the right pane, verify that the Current State is Idle for each channel
(assuming no active calls at present time).

IP Office System Status

wit Abolt

Sy=stem

& Alarms (5)

Extensions (26)

Trunks (19}
Line: 1

= 201 - 216
Active Calls
Resources
Voicemail

IP Hetworking

Status | Ukilization Summary Alarms

SIP Trunk Summary

Peer Domain Name: 172.16.1.50

Resolved Address: 10.1.1.1

Line: Murnber! 17

Murmber of Administered Channels: 0

Murmber of Channels in Use: 1]

Administered Compression: Auko

Silence Suppression: Off

SIP Trunk Channel Licences: Urilirnited . o
SIP Trunk Channel Licences in Use: 0

SIP Device Features; REFER {incoming and outgaing)

2 Idle 00:03:33
3 Idle 00:03:33
4 Idle 00:03:33
5 Idle 00:03:35
] Idle 00:03:33
7 Idle 00:03:33
g Idle 00:03:33
El Idle 00:03:33
10 de | 00:03:33 =l
Trace Trace All Pause | Fing | 24l Details Print. .. Save As...
Cnline

e Select the Alarms tab and verify that no alarms are active on the SIP line.

AVAYA

Help  Snapshot  LogOff  Exit

System

& Alarms (5)
Extensions (26}
Trunks (19

Active Calls
Resources
Woicemail

IP Hetworking

IP Office System Status

About

Skatus  Utilization Summary Alarms

Alarms for Line: 17 SIP 172.16.1.50
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e Verify that a phone connected to Avaya IP Office can successfully place a call to the
PSTN with two-way audio.

e Verify that a phone connected to PSTN can successfully place a call to the Avaya I[P
Office with two-way audio.

8. Conclusion

AT&T Mobility SIP Trunk Service in Puerto Rico passed compliance testing. These Application
Notes describe the procedures required to configure the SIP trunk connectivity between Avaya
IP Office and AT&T Mobility in Puerto Rico, as shown in Figure 1.

9. Additional References

[1] IP Office 7.0 IP Office Standard Version Installation, Document number15-601042, May 2011.

[2] IP Office Release 7.0 Manager 9.0, Document number15-601011, April 2011.

[3] IP Office Release 7.0 Voicemail Pro Installation and Maintenance, Document Number
15-601063 March 2011.

[4] IP Office Release 6.0 System Status Application, Document number15-601758, February 2010.

[5] IP Office Sofiphone Installation, Issue 2b, February 2011.

Product documentation for Avaya products may be found at http://support.avaya.com.
Product documentation for AT&T Mobility SIP Trunk Service is available from AT&T
Mobility.
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Appendix: SIP Line Template

Avaya IP Office Release 7.0 supports a SIP Line Template (in xml format) that can be created
from an existing configuration and imported into a new installation to simplify configuration
procedures as well as to reduce potential configuration errors.

Not all of the configuration information is included in the SIP Line Template. Therefore, it is
critical that the SIP Line configuration be verified/updated after a template has been imported
and additional configuration be supplemented using Section 5.4 in these Application Notes as a
reference.

To create a SIP Line Template from the configuration described in these Application Notes,
configure the parameters as described below.

To enable template support, select File, then Preferences. On the Visual Preferences tab, check
the Enable Template Options box.

gl IP Office Manager Preferences EH I

Freferences | Direckaries | Discovery  Yisual Preferences |Securit':.f | 'u'aliu:latiu:unl

Icon

. ISmaII j

[ Multiline Tabs
¥ Enatle Template Options
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To create a SIP Line Template from the configuration, on the left Navigation Pane, right click
the Sip Line (17), and select Generate SIP Trunk Template.

IF Offices SIP Line - Line 17

- R BOOTR (3 || stPLine |Transp0rt| SIP URI|olP | 738 Fax| SIP Credentials
Operator (3)
IPSO0YZ Line Murmber |1? 3:

[#-#59 System (1)

,_:_H--;I Line {19 ITSP Domain Mame |1?2. 16.1.50 In Setvice v
:: J q New 5 Use Tel URT r
gy |:’| Generate SIP Trunk Template Check 005 ¥
-1 _

e ‘ cut Chrlax Call Routing Method ITD Header j
T Qriginator number For
T_‘I = Copy Ctri+C forwarded and bwinning calls I
Paste Chrly
™
TR Delete Chrl-+Dnel —L,
=T )
s walidate
-3 <]
=19 Connect Ta... Chrl+T
T

The trunks settings are displayed as configured in Section 5.4. Adjust the settings if required and
then click on Export (not shown).

On the next screen, Template Type Selection, select the Country, enter the name for the
Service Provider, and click Generate Template.

| [l Template Type Selection M= E3
Lacale | Urited States [US English] =]
Country IF'uertu:u Rico j
Service Provider I.ﬁ.T &T Mobilind j
Generate Template | Cancel

The following is the exported SIP Line Template file, PR AT &TMobility SIPTrunk.xml:

<?xml version="1.0" encoding="utf-8" ?>
_<Template xmIns="urn:SIPTrunk-schema">
<TemplateType>SIPTrunk</TemplateType>
<Version>20110823</Version>
<SystemLocale>enu</SystemLocale>
<DescriptiveName>SIP Trunk</DescriptiveName>
<ITSPDomainName>172.16.1.50</ITSPDomainName>
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<SendCallerID>CallerIDDIV</SendCallerID>
<ReferSupport>true</ReferSupport>
<ReferSupportIncoming>1</ReferSupportlncoming>
<ReferSupportOutgoing>1</ReferSupportOutgoing>
<RegistrationRequired>false </RegistrationRequired>
<UseTelURI>false</UseTelURI >
<CheckOOS>true</CheckO0S>
<CallRoutingMethod>0</CallRoutingMethod>
<OriginatorNumber />
<AssociationMethod>SourceIP </AssociationMethod>
<ITSPProxy>10.1.1.1</ITSPProxy>
<LayerFourProtocol>SipUDP </LayerFourProtocol >
<SendPort>5060</SendPort>
<ListenPort>5060</ListenPort>
<DNSServerOne>0.0.0.0</DNSServerOne>
<DNSServerTwo>0.0.0.0</DNSServerTwo>
<CallsRouteViaRegistrar>true</CallsRouteViaRegistrar>
<SeparateRegistrar />
<CompressionMode>AUTOSELECT</CompressionMode>
<CallInitiationTimeout>4</CalllnitiationTimeout>
<DTMFSupport>DTMF_SUPPORT_RFC2833 </DTMFSupport>
<VoipSilenceSupression>false</VoipSilenceSupression>
<ReinviteSupported>true</ReinviteSupported>
<FaxTransportSupport>FOIP_T38</FaxTransportSupport>
<UseOffererPrefferedCodec>false </UseOffererPrefferedCodec>
<CodecLockdown>false</CodecLockdown>
<T38FaxVersion>3</T38FaxVersion>
<Transport>UDPTL</Transport>

<LowSpeed>0</LowSpeed>
<HighSpeed>0</HighSpeed>
<TCFMethod>Trans_TCF</TCFMethod>
<MaxBitRate>FaxRate_14400</MaxBitRate>
<EflagStartTimer>2600</EflagStartTimer>
<EflagStopTimer>2300</EflagStopTimer>
<UseDefaultValues>true</UseDefaultValues>
<ScanlLineFixup>true</ScanLineFixup>
<TFOPEnhancement>true</TFOPEnhancement>
<DisableT30ECM>false</DisableT30ECM>
<DisableEflagsForFirstDIS>false </DisableEflagsForFirstDIS>
<DisableT30MRCompression>false</DisableT30MRCompression>
<NSFOverride>false</NSFOverride>

</Template>
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To import the template into a new IP Office system, copy and paste the exported xml template
file to the Templates directory (C:\Program Files\Avaya\IP Office\Manager\Templates) on the
PC where IP Office Manager for the new system is running.

Next, import the template into the new IP Office by creating a new SIP Line as shown in the

screenshot below. In the Navigation Pane on the left, right-click on Line then navigate to New,
New SIP Trunk From Template:

IP Offices

- R BOOTP (3) || sIP Line |Tran5|:u:|rt| SIP URI|volP | 738 Fax| 5P Credentials

g% Operator (3)

= IPE00Y2 Lire Murnber 17 :

%57 System (1)
EF7 Line (19) ITSP Domain Mame  |172.16.1.50 In Service
Lol
""" *1 ] hew v | Hazatine
..... -
""" ™| ]  Generate SIP Trunk Template IP DECT Line
..... T3 . SIP Line
..... 1| 4 Cut el
1‘._.‘ 4 SES Line
..... F{|2y copy Chrl+C all
..... K | Mew SIP Trunk From Template |
..... 7 Paste Chrl4y
Lol

..... T4 75 Delete Chrl+Del ﬁ
""" Ti| | vaidate
..... -Tj = j
""" e Conneck Ta... Chrl+T
..... T |

On the next screen, Template Type Selection, verify that the information in the Country and
Service Provider fields is correct. If more than one template is present, use the drop-down
menus to select the required template. Click Create new SIP Trunk to finish the process.

ﬁ Template Type Selection I ] |

Lacale [ Urited States (U5 Englsh] =l
CoLinky
Service Provider [AT&T Mobility | I Display &l
Create new SIP Trunk | Canizel
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